
 
A Short Tour Of MS Excel 

 
MS Excel is powerful software for data analysis, modeling and graphing.  Many of you may have already 
used MS Excel in science, economics, and mathematics courses or you may have take 63.151 Personal 
Computer (PC) Fundamentals and Applications. 
 
This handout is provides a brief introduction to creating and changing the format for graphs that you 
generate using MS Excel.  At the end of this handout, you will find a discussion of how to determine the 
function equation for a data set using MS Excel. 
 
 
Creating A Graph 
 
Suppose that you have the following information and data set that you would like to analyze and model. 
 
The number of employees, in thousands, covered by federal civil service retirement in the years after 
1980 is given in the table below. 
 

Year 1980 1985 1989 1991 1993 1994 1995 
Employees covered 2,720 2,750 2,880 2,885 2,843 2,778 2,668 

 
We begin by entering the data in the spreadsheet.  To do this, we must first determine the input and the 
output for the data.  Since the number of employees covered by federal civil service retirement depends 
on time, the inputs are the years and the output is the number of employees covered by federal civil 
service retirement.  We will enter the inputs in the first column and the outputs in the second column; 
while can enter the data horizontally in rows, it is easier to use the Enter key between entries (enter data 
in columns) than to use the Tab key between entries (enter data in rows). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this initial examination of the data, we will use the years as given.  However, we will see that it is more 
efficient and easier to align the years so that the input becomes the number of years after a selected 
reference year rather than the year itself. 
 
Now that we have entered the data, we will create the scatter plot.  Left-click on the first input, A1 entry – 
column A row 1, and, holding down the left mouse button move the mouse until you have highlighted all 
the data.  When you release the left mouse button, the data will be highlighted as in the screen capture 
below. 
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Now we will graph the data.  We can use the Chart… entry on the Insert menu or use the Chart Wizard 
toolbar button; the Chart Wizard toolbar button displays a bar graph with blue, yellow, and red bars.  After 
launching the Chart Wizard, we select (XY) Scatter on the Chart Type menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you see, you can get help from the Office Assistant. 
 
We select the scatter plot in the Chart sub-type menu displayed on the right-hand side of the Chart 
Wizard dialog box and then click the Next button at the bottom of the dialog box. 
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In Step 2, we can check the Data range, for us the entries in rows 1 – 7 of columns A and B, and check 
that the program is using the data in Columns rather than in Rows using the Data Range tab.  We can 
check the data series and even add data series using the Series tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Since we do not need to make any changes to the data range or to add any series, we click the Next 
button at the bottom of the dialog box.  In Step 3, we can enter a Chart title, and labels for the horizontal 
axis, the Value (X) axis, and the vertical axis, the Value (Y) axis on the Title tab:  we enter the input, Year, 
for the Value (X) axis title, and the output, the number of employees, in thousands, covered by civil 
service retirement, for the Value (Y) axis title. 
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Using the Gridlines tab we can add or remove gridlines.  Here, we remove the horizontal gridlines by 
clicking the check box next to the Value (Y) axis Major gridlines.  Notice that these gridlines are removed 
in the scatter plot that is displayed in the dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If we wanted to display the data labels for the points, either the input value or the output value, we could 
do this by checking the appropriate boxes on the Data Labels tab of the dialog box.  Since displaying the 
data labels tends to clutter the graph, this is not an option that we will use. 
 
Clicking the check box next to Show Legend on the Legend tab allows us to remove the Legend.  We 
might consider using a legend if we had more than one type of data to compare within the graph.  In our 
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case, a legend wastes space within the graph since we have only one data set.  To advance to the final 
step in creating the graph for the data, we click the Next button at the bottom of the dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In Step 4, we can choose to include the graph on the current sheet, Sheet 1, or to put the graph on a 
separate chart, Chart 1, within the Excel workbook.  Since it is convenient to be able to view the graph 
and the data, we will select to locate the graph within Sheet 1.  To complete our initial graph, we click the 
Finish button within the Chart Wizard dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We can now edit 
this initial version of the graph.  In addition, if we left-click and then drag the graph within Sheet 1, we can 
move the graph to another location.  Here, we move the graph so that it is adjacent to the data. 
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Notice that when we left-click on the graph eight black squares are displayed at the corners and at the 
midpoints of the sides of the graph.  These squares indicate that the graph has been selected; this will be 
important when we import the graph in another computer application such as MS Word. 
 
Let us now edit the graph, changing the axis titles, the scale, the labels for the scale, the background for 
the graph, the graph border, and the point markers.  Let us begin by changing the axis titles. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Let us begin by editing the title for the vertical axis.  Right-click on the title and select Format Axis Title… 
on the popup menu.  We can use the Patterns tab to add a border and to change the color of the axis title 
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area; here, will not use a border and we will not change the color of the region.  We use the Font tab to 
change the font type and size; here we will use 8 pt regular Arial. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We can alter the text alignment along the axis using the options on the Alignment tab.  When our 
alterations are complete, we click the OK button at the bottom of the dialog box.  We change the title for 
the horizontal axis in the same manner. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To edit the scale and the axis labels, we right-click on the axis and select Format Axis… on the popup 
menu; here, we edit the vertical axis – the presence of the black squares at the ends of the vertical axis 
indicates that the vertical axis has been selected for editing.  We use the Patterns tab to edit the style, 
weight, and color of the axis as well as the location and type of tick marks along the axis.   
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We edit the scale using the Scale tab; here, we change the Minimum value to 2500, the Maximum value 
to 3000, the Major scale to 100, and set the horizontal axis to cross the vertical axis at 2500 on the 
vertical axis.  We use the Font tab to edit the font used for the scale labels; here, we change to 8 pt 
regular Arial.  If we want to change the alignment of the scale labels, we would use the Alignment tab.  
When the changes are complete, we click the OK button in the dialog box.  We edit the horizontal axis in  
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the same manner; 
here, we use 8 pt regular Arial for the font, use a Minimum value of 1975, a Maximum value of 2000, a 
Major scale of 5, and set the horizontal axis to cross the vertical axis at 1975 on the horizontal axis.  To 
change the background color of the graph, we right-click on this region, the Plot Area, and select Format 
Plot Area… on the popup menu. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To remove the border, we click None on the Border menu, and to select a white background, we click the 
white square.  Be careful of selecting None on the Area menu since this will produce a transparent Plot 
Area.  When we complete editing the plot area, we click the OK button at the bottom of the dialog box. 
 
To remove the border of the graph or to change the chart colors, we right-click on the outer white region 
of the graph, the Chart Area, and select Format Chart Area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Since we want to 
edit the border, we 
select the Patterns tab:  we click None on the Border menu.  If we wanted to change the Chart Area color, 
we would select one of the Area colors.  We use the Font and Properties tabs in a similar manner.  As 
usual, we click the OK button at the bottom of the dialog box to complete our changes. 
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To change the size of the chart once we have completed our formatting changes for the graph, we left-
click to select the graph (indicated as before by the presence of the eight black squares at the corners 
and the midpoints of the sides of the graph) and move the cursor to one of the black squares.  When the 
cursor becomes a two-headed arrow, left-click and, holding down the left mouse button, drag the graph 
the desired size; it is best to use one of the corners.  The dotted outline indicates the new size for the 
graph.  When the graph is the desired size, release the left mouse button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finally, to change 
the point markers, 
we right-click on one of the points and select Format Data Series on the popup menu. 
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We change the data marker on the Patterns tab.  Here we select the round marker and change the 
background and foreground colors from blue to black; if we want to mark a point with an open circle to 
indicate that the point is not included, we choose the background color to be the same color as the Plot 
Area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Notice that there are other options that we can change, for example, we can add or change the Data 
Labels using the Data Labels tab.  Again, we click the OK button at the bottom of the dialog box to 
complete the changes. 
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The screen capture above displays our completed graph within the Excel workbook. 
 
Importing A Graph Into Another Application 
Suppose, for example, we want to import our graph to a MS Word file.  We do this by selecting, copying, 
and pasting the graph into the MS Word file.  It is better to use a Paste Special rather than a regular 
Paste because using Paste results in our actually pasting a MS Excel Chart into the MS Word file.  While 
this can be convenient for editing, these files can become too large to save and can cause the computer 
to crash. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Using Paste Special, we can save the graph as a Picture that does not radically increase the file size.  
So, we can select the graph (left-click on the Chart Area) and use Copy on the Edit menu, the Copy 
toolbar button (toolbar button with two sheets of paper), or the Control-C key sequence, or right-click on 
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the Chart Area and select Copy.  Then, we move to a MS Word document, for example this document, 
and select Paste Special… on the Edit menu.  We select to paste as a Picture (Enhanced Metafile). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The picture is displayed when we click the OK button in the Paste Special dialog box.  Then, we can 
move the graph within the MS Word document in the same manner in which we moved the graph within 
MS Excel.  Right-clicking on the picture and selecting Format Picture, we can control the location and the 
size of the picture within the document using the Layout and Size tabs, respectively. 
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Notice, in the next screen capture, that we press Enter to create a region within which to position the 
graph in the document.  If you choose to change the size of the graph using the mouse, be careful to use 
one of the corners and to drag diagonally so that the graph is proportionally resized.  It is best to create 
the appropriately sized graph within MS Excel before pasting the graph into another application since 
resizing the graph can cause distortion. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Modeling The Data 
Examining the scatter plot, we see that a cubic function would be appropriate since the scatter plot 
displays two curvatures and a maximum.  Thus, we would like to use a polynomial function of degree 
three.  To create this function, we right-click one of the data points and select Add Trendline… on the 
popup menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Using the Type tab, we select Polynomial in the Trend/Regression type menu and change the Order to 3.  
Again, we click OK to generate the function. 
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Right-clicking the trendline and selecting Format Trendline…, we use the Options tab to select to display 
the equation for the data on the graph. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After clicking the OK button, the equation will be displayed on the graph.  To move the equation within the 
Chart, left-click on the equation to select the equation, and, holding down the left mouse button, drag the 
equation to a different location in the same way in which you previously moved the graph within MS 
Excel. 
We can change the type and size of the font of the equation in the same way in which we changed the 
fonts for the scale and axis labels.  Here, we right click on the equation and select Format Data Labels… 
on the popup menu; as before, an 8 pt regular Arial font is used. 
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Examining the equation, we see that the coefficients are rather large, for example the constant term is 
“5E+09” which denotes 5 × 109.  This occurs since we did not align the years.   
 
In order to get a useful function equation, we now align the inputs with the year 1975.  The original input, 
the years, will now become the number of years after 1975.  So, we will replace the current inputs 1980, 
1985, 1989, 1991, 1992, 1993, 1994, and 1995 with 5, 10, 14, 16, 17, 18, 19, and 20, respectively.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Since we are 
changing the inputs, we must adjust the input scale and the label for the horizontal axis for the graph; we 
enter the new inputs and change the scale in the same manner as previously discussed.  To change the 
horizontal axis title, double click on the “Year” and edit the text.  As you make these changes, you will 
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notice changes in the graph and in the function equation.  Once you have adjusted the scale, you will be 
able to view the new graph (displayed in the screen capture above) and the new function equation. 
 
Changing Options 
If you want to change any of the Chart Options, for example add axis titles that you did not initially 
include, right-click any part of the graph and select Chart Options … on the popup menu.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Using the Chart Options dialog box, we can add and remove axis titles, a legend, gridlines, and data 
labels. 
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